From the Chief Editor's Desk

Papawoob

Hello again everyone! I hope everyone is ready for another month of good reading. We
have the next to the last chapter of the KDE User Guide, a list of keyboard shortcuts,
and some tips on how to make your laptop run cooler.
We also have a new PDF layout team and their first collaborative creation is this
months Magazine. I hope you all enjoy it. I would also like to apologize to anyone who
took offense to last months article "Ubuntu's Hype is Misleading."No ill will was meant
toward any of the distros mentioned in the article. For a further take on this subject
please read the "Letters to the Editor" section.

Next month we will see the final installment of the KDE User Guide. We will also start bringing you slowly into using
the CLI (Command Line Interface) with articles explaining what it is and what you can do with it. I would also like to
hear from any of you that are interested in seeing a Gnome User Guide, or an Xfce User Guide, etc.
I would like to again invite everyone to our new site to join in on discussions at our forum or to read the current
months Magazine. You will also find links to all the articles written by particular Authors (if you have a favorite.) You
can find us at www.pclosmag.com
Papawoob

Letters to the Editor
PCLinuxOS is quite interesting. I run it in dual boot with XP. A serious drawback for Linux in general
remains the boot time:
Xp = 15-20 secs. Linux = 1min and more.
I believe that Linux will always stay behind unless the boot time is improved.
John Talbot
Thanks John for sending this letter and I am glad that you find PCLinuxOS interesting. Since installing
PCLinuxOS 2007 I have found that the gap in boot times has closed considerably. I think if you stick
with the dual boot for awhile you will begin to appreciate all the other benefits of Open Source
software versus that of the proprietary types, like cost and the need for fewer resources.
Papawoob
Hi, and thank you for a good and fun magazine, I have made some contributions to the PCLOS
hardware database, I really want that you publish my personal review of PCLinuxOS in the next issue.
Perhaps this could help some new users in deciding which distro to use.
Thanks,
Jose Cesaro
Thanks for the compliments Jose! Read on to see your review.
Papawoob
Could you write an article on how to install R for Statistical Computing on PCLinuxOS?
Mr. Muchtar Kusuma

As it is not recommended to install packages that are not in the PCLinuxOS repositories, I would
suggest to make a request in the Package Suggest section of the main forum.
Papawoob
Ubuntu's Hype is misleading.
What a load of crap. I don't know if I should laugh or cry. I've never seen a more biased appraisal of a
Linux distro than this article's 10 out of 10 prefer PCLinuxOS, and 0 out of 10 prefer Ubuntu. Get real.
I'm an Opensuse user myself, so I'm not directly mingled into your catfight.
"I'm running a computer institute and I have new, middle and advanced
users. People who know Linux very well and those who don't even know "L" of Linux."
I smell a rat.
If you want to be considered a serious publication, don't claim objectivity on false pretenses.
PCLinuxOSMag is advertisement and service for PCLOS users. Don't try to produce fake or extremely
biased "tests" written by "IT professionals". I don't care, if the test is actually carried out or if Anant
Gowerdhan is in fact "running a computer institute". It's still a poorly written and biased test.
That's all.
Thank you for your attention
Mads
Thank you for your letter Mads. This article is simply one individual's personal experience, and
speaking for the Magazine Staff , we did not publish this article with any ill will intended. Many
PCLinuxOS users (myself included) multi-boot Ubuntu (or one of it's derivatives) along with
PCLinuxOS. When deciding whether to run this article, I looked at this article as a testimonial of the
sort where the testifying individual lists his way through the different distros that he has tried and
rejected on his way to why he decided on the one he is testifying about. The Magazine Staff and
myself would like to make it clear that it does not matter which version of Linux you use, as long as

you use Linux.
Papawoob
PCLinuxOS Magazine
Editor-in-Chief
Hi Papawoob,
In the attached document, I have some detailed feedback on one of the articles in the last magazine
release. I apologize for the length, but I hope you find my comments useful.
Al
Thank you Al, for your comments on the Ubuntu's Hype is Misleading article. I would have loved to
publish the entire PDF, but am unable due to space constraints. Your points were well thought out
and I will take them into consideration when reviewing articles in the future. We try to edit for
readability, while leaving the article as close to the original as possible so as to maintain the Author's
style. As I stated in the previous "Letter", I was looking at the article as a testimonial and did not
intend any ill-will towards any other distro.
Papawoob
Browsing through all the editions of this magazine published so far, I must say it really is one of a
kind! It's really easy and concise, making it perfect for newbies and pros alike. Keep up the good
work!
As for PCLinuxOS itself, it's nothing short of a miracle. Having tried lots of different Linux
distributions, this has been the only one that really managed to get all of my hardware (laptops,
desktops, media centers, etc.) to work properly.
Even my wife wanted it installed on her laptop, since she'd been having problems with malware and
viruses as well as sluggishness of the OS lately. PCLinuxOS 2007 to the rescue, her old laptop now
seems like a racing machine compared to before and the virus and malware threat is gone now.
I can encourage everyone to try out PCLinuxOS and read through all the editions of this magazine.
The word needs to be spread that there finally is a way to escape the monopoly and PCLinuxOS is
definitely one of the best ways to do it!
Best regards,

Jay
Thank you very much Jay for your beaming endorsement of both this Magazine and the Development
Team. Letters like this are what makes our efforts seem worthwhile.
Papawoob
"Linux is an entire Operating System in itself. What is an Operating System? It is a set of computer
programs meant to manage the hardware and software of a computer you want to run."
I had to disagree with you in this matter. Linux is just the KERNEL of your so-called Operating
System. Most of the tools, programs, and libraries included to make it a system usable to users are
the works of the Free Software Foundation or simply the GNU organization. To call it as an Operating
System, GNU/Linux will be the appropriate term.
Edsel Elpedes
Thank you very much for your clarification of this point. The term Linux is often misused in this way.
Papawoob

Testimonials
I installed PCLinuxOS yesterday. To include the download and burn, having to start the installer a
second time, updating as the suggestion stated somewhere in the forum, tinkering with things to
figure them out, installing a few "I can't live without "em" necessities, and configuring a few things
such as the 3-D, all-in-all it took somewhere in the neighborhood of five hours. Not bad at all,
considering the first and only time I installed Vista took two days. Xp Pro was usually an all day job
because of service pack 2.
I'm pretty new to Linux myself. Been totally away from Windows going on two months now. I read
somewhere there is close to 700 Linux distro's out there. I'm beginning to think I've tried them all. I
do know I had a container that contained 100 cd's and I'm down to around 30 or so left.
There's a few minor bugs I've found here, but I must say, I haven't been this impressed with any
other Distro. VectorSoho is the only thing I've found that compares to PCLinuxOS. This distro is as
fast as SOHO on my system and has a lot more to offer, and just as simple to figure out without
spending hours searching for the code for this or that. I haven't had to touch the terminal one time
yet. I'm so disappointed!
I'm running a Dell Dimension 4600 with an Intel something or other card for the DSL connection, an
Nvidia Geforce 6200 graphics card, the original Pentium 4 processor, 250 gig sata H/D, 1 1/2 gigs of
ram and a generic KDS monitor. I also use an IOGEAR wireless mouse and keyboard as well as a
Logitech trackball. There have only been two other distro's that picked up and auto configured my
wireless mouse. PCLOS makes the third to pick it up. Granted I dunno what I'm looking at and
reading yet, but on the boot it states it has loaded the 686 kernel. If this old pc is running a distro
that is designed for a 686 processor and doing wonderfully, I just might hang onto it for a bit longer.
As I'm implying above, so far I think I've found my home.
I gotta do a bit of reading so I'll know where to post the few bugs I've found and find out how to set
something so the mod doesn't have to move my post around. So in closing, I'll say this, PCLinuxOS,
in my opinion is the distro that Dell needs to be putting on their systems. It's the BEST!

Windtalker
I've tried over a dozen different Linux distro's and this one has a lot of the best features and it's
getting better. I've got it installed on 2 desktops and 1 laptop. I also have it customized to my tastes
with all of the software I can possibly install, (i.e., graphics, office, multimedia, sound, astronomy,
photography) etc. etc. etc. I'm not new to Linux (been playing with it since Suse 6.2.
I will never ever go back to Windows with it's restrictive licensing, restrictive terms of use, tons of
viruses, blue screens of death, the multitude of infinite updates and security plugs, and 128 bit
installation registration codes. etc. Also, add to this the infinite commercial software developers keep
plugging for their 'new and improved' 'whiter than 'white' low suds software and their brainwashing
tactics to get people to spend more and more of their hard earned cash for the 'newest' improved
software.
The philosophy behind 'open source' Linux is the way software should be - 'free'. No gimmicks. No
hands outstretched for money. No terms as to how to use and how many machines to install it on.
Keep up the good work.
Rich

My Personal Review of PCLinuxOS 2007 Edition
Jose Cesaro
The system: AMD Athlon 3000+ Asus a8v MOBO, Nvidia GeForce FX 5200,
Excelstor Drive and Liteon dvd-cdrom drives.
I finally gave a shot to PCLinuxOS in April, downloaded the TR4 release, burned it, and then started it
up. I have to tell that I instantly decided to install this great distro on my system, and it was easy and
fast.
Lets start the review by telling why PCLinuxOS is different.
First. PCLinuxOS comes with all the codecs and multimedia support you would
need in your Linux distro, such as, Java, flash player 9 which is great, AVI, ogg, mpeg, mp3 codecs,
also DVD and others.
Second. Great control panel, it recognized my Advantek USB WLAN Card, just needed the .inf files
and GO!
Third. As a Mandriva based distro, it has awesome system management tools. If you are thinking on
using AIGLX or XGL, this is your distro. Just install the drivers with Synaptic, then enable beryl-compiz
and restart X.
Fourth. FAST! This distro is not bloated at all, it's awesome how it can run Bittorrent, Frostwire, Open
Office, Synaptic, and Firefox so fast.
Fifth. Stable. Finally, I have one distro that will not fail booting or recognizing new hardware.
Everything went fine, burning dvds with k3b, wifi networking, and Online games (Server, Client).
On a scale of 1 to 10, I would give it a 9.5.
Thumbs Up: multimedia support, system management tools, stable, and fast.

Thumbs Down: No decent ftp programs, only KFTPGrabber, which fails uploading files.
Bottom Line: If you want an All-In-One distro with excellent multimedia
and hardware support, make this your choice.

Attention!

Have you ever gotten tired of looking at those “Designed for Microsoft Windows” stickers on your PC or laptop
when you know it is “Powered by PCLinuxOS?” If you are like many other PCLinuxOS users and myself, you can
now do something about it. Thanks to the efforts of lgross1949, and Gryphen (graphics), you can now order
yourself as many as you need to replace them, and every cent of profit goes to Tex & the Ripper Gang to help fund
the continuing development of our beloved OS. Below you can see what they look like.

You can order these by emailing lgross1949 at: lgross1949@yahoo.com or lgross1949@powerc.net. After you
have placed your order he will send you a billing statement through PayPal and you can pay with Credit or Debit
Card, or Checking Account. You don't have to have a PayPal account to use it. They can be purchased for $4.00
US and that includes shipping anywhere in the world. So let's get with it and order yours today!

Tips for a Cooler Laptop

From the Forums

Hi! My laptop gets very hot so when I had Win XP installed I used a program called Speedswitchxp. When I
installed PCLinuxOS I had the same problem and this was the solution:
Part1  make sure cpufreq is installed

1.Go to Synaptic (you can find it in your panel)
2.Search for cpufreq
3.If cpfreq is not installed, install it
Part 2  make sure cpufreq starts at boot

1.Go to Administration Center (Configure Your Computer, also
found in your panel)
2.Click on the “System” tab
3.Click on “Enable or disable system services”
4.Find cpufreq and mark “On boot”
5.Press “OK”
Note: Cpufreq does the same thing for Linux as
Speedswitchxp does for Windows. It is a program that clocks
down the processor when the computer does not need the
power and clocks it back up when the computer need the
power.
Fig. Services window
Another tip for cooling your laptop/desktop is to install a
FireFox addon called FlashBlock. This addon blocks Flash animation. This way you can block flash ads. This

makes my laptop cooler.

If you find that these software solutions are not enough to keep your laptop in the temperature range that you
desire then a hardware solution may be a more practical solution. I would suggest what I call a "cool pad." It has a
couple of fans that blow air over the bottom of the laptop and takes its power from a USB port. Just having that air
movement will keep most laptop temperatures in the low to mid 50's c range. Hope this helps!

The Hardware Database Needs You!
Hello all,

Jmiahman

On behalf of the crew at PCLinuxOS Hardware Database we would like to say thank you for all of your submissions
and support of the Hardware Database. Currently we have 250 hardware submissions that allow users of
PCLinuxOS to view and rate their working or non working hardware. When I think about it, that’s really a lot of
hardware. So thank you. We still need your help though and you may be aware there is a lot of hardware out there
and I know a lot of you have it working. I have created a FAQ (that can be found in the FAQs tab at the top of the
page) on how to navigate the site if there’s any confusion and a short explanation of the "User Menu". I’m planning
on creating a FAQ and a PDF that goes more into detail about hardware submissions. Really what is needed is:
(items in bold match the fields on the submission form)
Item title: A title to the entry

PCLinuxOS Version: What PCLinuxOS distribution it’s been tested on. I was allowing .93a submissions but now it’s
EOL (end of life) so now I’ve included TinyMe and Sam so they don’t feel left out.
Item Summary: A short description of the product in a few lines.

Item description: An in depth description with Specifications, etc..
Images: An image of the product.

Meta Description: This is a short, few word description for search purposes.

Meta Keywords: This is for searches also, these will be keywords that will bring up this hardware in a search.
Review Title: A title for a short review.

Ratings: Rate how well the hardware works with PCLinuxOS, not based on how well you like the hardware, or
hardware deficiencies outside of the realm of PCLinuxOS. Rating system follows:

1. Does not work at all
2. May work but is not effective, fast enough, etc.. to be acceptable.
3. Works, but is maybe slower than usual, or has small to minor
discrepancies.
4. Works well, but not "out of the box." May take some major steps to get working or not all features may work.
5. Works either "out of the box" or near enough (maybe, simply copying a firmware file) but every feature works as
should.

Review Comments: This is the special place where you can tell the rest of the users your experience with how well
the hardware worked/didn’t work with PCLinuxOS. You can even brag about how great PCLinuxOS is if you feel like
it.

Once you’ve submitted the hardware, it goes into a queue. I look it over, fill in any missing specifications, pictures,
and tidy things up a bit. Your entry doesn’t have to be perfect as long as I get a part number or a descriptive enough
title I can easily google your device and fill in the blanks as needed. If you like the challenge of being a perfectionist,
most of the specifications I find come from the manufacturer, cnet, dealtime, amazon, newegg, and a few other
sites. I format the tables so they look nice and that is how things work. If you're a Linux guru and know how to get
hardware IDs through lspci, lsub etc.. that information is very much appreciated and will be placed after
specifications in the entry when supplied.
I can’t stress this enough though, we need you to do submissions. The more submissions the more successful the
site can be and the more useful it will be to other users. I have big plans for this site and hardware submissions in
the future. Please help make it a worth while venture and submit your hardware.
Please do your submissions at http://PCLinuxOSHWDB.com If you have problems getting to the Add Hardware
Form read the FAQ on site navigation and make sure you're logged in with your Hardware Database account.
Thank you all,
jmiahman

KDE User's Guide - Chapter 9
Internet Email

Internet email has become one of the most popular applications on the Internet. An Internet experience is not
complete without the usage of email. In this chapter we shall be describing two commonly used email software:
Kmail and Mozilla Thunderbird.
Email Requirements
There are two main types of Internet email systems: webmail and POP3. Webmail, as the name implies, makes
use of a web browser to read, compose, send, and manage your mail. POP3 email makes use of a POP3 email
client to download your email from a server housing your email mailbox. The main difference between a webmail
system and a POP3 email system is that for the former, generally, you have to be online to the server housing your
mailbox to access and manage your mail. For the POP3 system, you need to be online to the server only to
download your mail, after that you can go offline to read, reply and manage your local mail storage. You only need
to go online again when you want to send out your email.
In addition to having a webmail account somewhere on the Internet, webmail needs only a web browser and
Internet access to work. Examples of popular webmail services are those from Yahoo and Hotmail. Most ISPs also
offer webmail services in addition to their traditional POP3 email services.
To use POP3 email you will need to have a POP3 email client software running on your computer. Linux has many
different email programs which support POP3 email. In addition, you will also need to know the name of the server
on which your POP3 mailbox is located (the POP3 server), as well as the name of the server which allows you to
send out (relay) mail through it (the SMTP server.)
Note:
Of course you will need to know your Internet email address irrespective of whether you are using webmail or
POP3 email!

Since the usage of webmail involves using your browser mainly, all you have to do is go to the website of your e
mail provider (ex. Yahoo.com) and after logging in, click on the mail tab. Next, we will be looking at the POP3 setup
and usage of KMail and Mozilla Mail.

KMail
KMail can be launched from the Main Menu:
Main menu > Internet > Mail > KMail

Invoking KMail for the first time will bring up a dialog box that informs you that this is the first time you have used
Kmail and asks if you would like to set up your email account.

Fig. Kmail Welcome
If you click "Next", a new dialog box will appear. This box contains five choices that represent the different types of
mail accounts that you would be likely to use with Kmail. Since most people use POP3 we will cover setting this
choice up.

Fig. Account Type
Highlight "POP3" by left clicking once on it and then click "Next." This will bring up the next dialog box which will
allow you to enter your account information.

Fig. Account Information

In this dialog box you will enter the information needed for Kmail to identify the account that you wish to send and
receive mail with.
In the "Real name" box you should enter the name that you want to identify who you are when sending mail.
In the "Email address" box you need to type in the email address that was provided by your ISP.

In the "Organization" box you can enter the name of your business, organization, or leave it blank if this is for use
with your home computer. When you have finished entering your information click "Next." You will now see the
Server Information dialog box.

Fig. Server Information
In this box we will enter the names of the servers that will be sending and receiving your mail for you. Your ISP
should have provided you this information so just type in the name of your POP server (this one retrieves your mail)
and then your smtp server (this one delivers your mail.) If for some reason you would like to use a secure
connection you can mark the box next to "Use secure connection (SSL)." This will require you to configure SSL
which is beyond the scope of this article. When finished click Next.

Fig. Login Information
As you can see from the figure above, our next dialog box is for your login information. You probably chose your
own login name and password, and your ISP approved it, so you should have this information at hand. Go ahead
and enter your login name first and then your password. Kmail will use this information to gain access to your ISP´s
popserver to bring your mail to your computer and also to send your mail through your ISP´s smtpserver. Once this
information is entered, click next, and you should see Kmail main screen as seen below.
Optionally, once you have reached the main window you can use "Configure Kmail" to modify almost every aspect
of Kmail. You can find it by clicking on "Settings" in the toolbar at the top of the window.

Fig. Kmail Main Window
Receiving Mail
To receive your mail you can click on the "Check Mail In" button. It is the fourth button from the left, on the second
toolbar as seen below:

Fig. Receiving Mail
If you would like Kmail to fetch your mail automatically each time you open it, you will have to go to:
Settings >Configure Kmail
and then click on the "Accounts" tab as seen below:

Fig. Receiving Mail 1
Once you have reached this window simply click on the box to the left of "Check Mail On Startup" and then click
"Apply." Clicking on OK will close this window and the next time you open Kmail, your mail will show up
automatically.

Only a very brief description of the functionalities and features of KMail are given here. The user should refer to the
Help button on the menu bar for more details.
Inbox Folder
The Inbox houses the email sent to you which you have downloaded from the POP3 server. To see what is in your
Inbox click on the Inbox icon. If you have emails in your Inbox, they will be displayed here. To read an email select it
by clicking on it in the Subject Window.

Fig. KMail Inbox
Composing Emails
To compose an email, from the Inbox screen, click on the New button.

Enter the email address of the recipient as well as the subject. The latter should be a few words describing the
contents of the mail, but it should also not be too long. If you need to CC the mail to another email address, click on
the View button on the top Menu bar and select CC field which will be displayed. After composing the email, you
can send it.

Fig. KMail Composing Email
Offline Mode
If you are on a dialup connection, it is very likely that you will want to compose all the emails that you want to send
offline first before actually going online to send them. To do this, click on the File item on the menu bar at the top
and select "Work Offline"
File > Work Offline

(if the File menu shows the item Work Online then it means that you are already offline, i.e. It is a toggle between
online mode and offline mode.)
In the offline mode, when you compose and send your mail they will not be sent out, but rather they are stored
temporarily in your Outbox folder. You can send them off later after connecting to the Internet by selecting:
File > Send queued messages

Sending and Receiving Emails
To send the emails you have composed, connect to the Internet first and then select Work Online from the File
menu. Click on the Check Mail In button to receive mail, and click on the File > Send Queued Message menu item
in the menu bar. Unsent mail in your Outbox will be sent out and any incoming new mail will be placed in your Inbox.
Deleting Emails
Any mail deleted from your Inbox will be placed in the Trash folder. You should periodically empty the Trash by
clicking on File from the menu bar and selecting Empty All Trash Folders. Alternatively, you can right click on Trash
and choose Empty Trash.
Folders
Mail messages in KMail are organized in folders similar in concept to the File Manager. To view your KMail folders,
click on them in the left side of KMail.

By default the following email folders are created under the Local Folders: Inbox, Outbox, Sent , Drafts and Trash.
There is also a Templates folder. You can create a new folder by rightclicking on Local Folders, selecting New
Folder and enter the Folder name. You can move and copy mail messages between folders by rightclicking on the
message in the Subject Window and selecting “Move to Folder” or “Copy to Folder”.

Mozilla Thunderbird
Mozilla Thunderbird has been around a few years now and has evolved into an awesome desktop email
application. Below are a few features from the Thunderbird website.
Advanced Folder Views
Thunderbird 2 offers a variety of ways for you to organize and display your folders, whether by favorites, recently
viewed or folders containing unread messages. As always, you can also set up RSS and newsgroup folders to stay
on top of news and your interests. Thunderbird 2 also allows you to maximize your message view pane by opting
for a folder drop down menu instead of the traditional sidebar.
Message Tagging
Thunderbird 2 allows you to “tag” messages with descriptors such as “To Do” or “Done” or even create your own
tags that are specific to your needs. Tags can be combined with saved searches and mail views to make it easier to

organize email.
Message History Navigation
Thunderbird 2 offers message history navigation that allows you to click “forward” and “back” much like in your Web
browser. You can now quickly toggle between messages and folder views.
Improved Search
Thunderbird 2 features a find as you type pane that speeds up searches within displayed messages. Thunderbird
also offers quick search, which starts showing search results as soon as you start typing in search terms.
Stay Informed
Thunderbird 2 has been updated to provide more informative and relevant message alerts containing sender,
subject and message text for newly arrived messages. Folders provide a pop up summarizing new messages in
that folder.
Easy Access to Popular Web Mail Services
Thunderbird 2 makes it even easier to integrate and use various Web mail accounts from one inbox. Gmail and
.Mac users can access their accounts in Thunderbird by simply providing their user names and passwords.
Phishing Protection
Thunderbird protects you from email scams which try to trick users into handing over personal and confidential
information by indicating when a message is a potential phishing attempt. As a second line of defense, Thunderbird
warns you when you click on a link which appears to be taking you to a different Web site than the one indicated by
the URL in the message.
Cutting out the Junk
Mozilla has updated Thunderbird’s popular junk mail folders to stay ahead of spam. Each email you receive passes
through Thunderbird's leadingedge junk mail filters. Each time you mark messages as spam, Thunderbird “learns”
and improves its filtering so you can spend more time reading the mail that matters. Thunderbird can also use your
mail provider's spam filters to keep junk mail out of your inbox.
Open Source, More Secure
At the heart of Thunderbird is an open source development process driven by thousands of passionate,
experienced developers and security experts spread all over the world. Our openness and active community of
experts helps to ensure our products are more secure and updated quickly, while also enabling us to take
advantage of the best third party security scanning and evaluation tools to further bolster overall security.

Thunderbird’s update system checks to see if you’re running the latest version, and notifies you when a security
update is available.
Outfit Your Inbox
Thunderbird users can increase Thunderbird’s functionality and appearance using hundreds of addons. A
Thunderbird addon can let you manage contacts, place voice over IP calls, listen to music, and keep track of
birthdates all from your inbox. You can even change the appearance of Thunderbird to suit your tastes.
Message Templates
Thunderbird 2 allows you to easily set up message templates to save you time – especially if you have to send the
same mail message repeatedly.
Addons Manager for Extensions and Themes
The new Addons Manager improves the user interface for managing extensions and themes, making it even easier
for you to customize Thunderbird 2. Install, uninstall, enable and disable your addons in a single place.
As you can see, Thunderbird has enough features to satisfy just about everyone. Now that you know a little about
this wonderful application, lets move on to set it up. You can find Thunderbird by going to the menu.
Menu > Internet > Mail > Mozilla Thunderbird

The first time you open Thunderbird you will see a window like the one below:

Fig. Import Wizard
In this window you can choose to import your mail, address book, preferences, and account settings from another e
mail client, if you have one. If Thunderbird detects any other email clients it should list them in this window. Simply
choose which one you want to import from and click Next.
If you chose one, the next window you would see would inform you if the importation was successful or not. If it was
a success, then you would click Next. This will bring up the next window which looks like the one below:

Fig. Account Wizard
The Account Wizard is where you can setup your email account(s), RSS news feeds, Newsgroup accounts, and
even use Thunderbird to manage your Gmail account locally. As we did in Kmail earlier, we will be setting up a
POP3 email account. If you need guidance setting up one of the other types of accounts there are plenty of
answers in the "Help" tab located at the top of the window or at the Mozilla Thunderbird website. Choose "Email
account" as in the figure above and then click Next.

Fig. Identity

Our next window will be where we establish our identity. In the box next to "Your Name" you need to type in the
name that you would like others to see when they receive mail from you. The next box is the one where you will
enter your email address. When you have finished, click Next.

Fig. Server Information
This next window is where you will enter names of the servers that will fetch (pop) and send (smtp) your mail. You
should have received this information when you set up your ISP account. If not, you can ask your ISP for this
information. Under "type of incoming server", click on "POP." In the box next to "Incoming Server" type in the name
of your incoming server. This will usually be "popserver" and then the address of your ISP.
Now we need to check the box next to "Use Global Inbox." Doing this will save your incoming mail on your
harddrive which will allow you to work with your mail offline. This will be especially important to those of you on
dialup connections. The last thing we need to do in this window is enter the name of your outgoing server. Type the
name in the box next to "Outgoing Server." As with the popserver above, the server name will usually be smtp

server and then the address of your ISP. When you have finished, click Next.

Fig. User Names
In this next window, as you can see above, you will need to enter your incoming and outgoing user names. In most
cases these will be the same. After entering these, click Next.

Fig. Account Name
In this window you need to name this account. As you can see in the window above, you can name it anything you
like. For people who use different accounts for different aspects of their lives, this is where you can name it for
whatever purpose you will use this email address. After entering the name you prefer, click Next.

Fig. Congratulations

As the window above says, Congratulations! This page displays all of the information that you have entered in the
last few windows. This is your opportunity to review the information and check for any errors. If everything looks
good, go ahead and click Finish.Fig. Congratulations

Fig. Congratulations
As the window above says, Congratulations! This page displays all of the information that you have entered in the last few windows.
This is your opportunity to review the information and check for any errors. If everything looks good, go ahead and click Finish.Fig.
Congratulations

Fig. Processing
When you clicked Finish, the window above will appear and when the processing is finished it will ask you for your
password. Enter your password and if you want to, check the box that will save your password. Press the Enter
(Return) key on your keyboard and you will then receive any mail that you have on your mail providers server.
Using Mozilla Thunderbird

The default startup screen has three main sections:

left panel displaying mail boxes and folders
right main mail display panel
top panel containing the main menu bar and buttons

The left panel displays in a treedirectory format the email accounts that have been configured for the system and
the mailboxes under it. The Local section contains the folders and messages that are not from any of the accounts
created and associated with an Internet email account and thus considered local to the system. Note that this
includes any unsent mail messages.
Reading Mail
To read any email in your Inbox, select the Inbox folder under the desired mail account in the left panel. A list of the
messages in your Inbox will be displayed in the top part of the right panel showing the email sender and subject
header. To view the mail content click on the desired message in the top right panel and the message body will be
displayed in the bottom right panel. Scroll as required to read the entire message.
Composing Mail
To compose a new email click on the Write button on the top menu. Alternatively you can also click Message on the
menu bar and choose "New."“Compose (Ensure that you have selected the appropriate email account on the
system by clicking on the appropriate account name in the left display panel.)

Advertisement

Fig. Composing Mail in Mozilla Thunderbird
The From field is automatically filled in for you from the email address you provided in the setup for the account
currently being used.

The To field has to be filled in with the email address (es) of the recipient(s). Highlight a name from your address
book and click on the "Add to To" button and it will show up in the To window. You can also double click a name to
accomplish the same thing. Repeat this process as many times as necessary.
The other email header fields like Cc and Bcc can be selected by clicking on the To field button.

The Subject field should also be filled in with an appropriate subject header. You should avoid being too verbose for
the subject header.
The mail message body can be entered in the right bottom panel provided and any file attachments can be added
by clicking on the Attach button at the top and then selecting the file.
Sending Mail

After composing the email, you can either send it off immediately if you are already online, send it later, or keep it as
a draft to be edited later.
To send it off immediately select the Send button. If the message was sent successfully it will be stored in the Sent
folder.
To send it later, select from the main menu at the top,
File > Send Later

The message will be stored under the Unsent Messages in the Local Folders section. In this way you can compose
all the emails first and store them before sending them all in one go. Later on you can send all the unsent
messages by selecting from the main menu at the top,
File > Send Unsent Messages

This method of sending is especially useful if you are on a dialup Internet connection where you can compose the
messages offline and then dialup later to send the messages.
To save it as a draft, select from the main menu at the top,
File > Save As > Draft

The email message will be saved in the Drafts folder under the current account section. Later, to edit the saved
draft, select the Drafts folder under the account, click on the draft message to edit that is being displayed in the top
right panel and select from the top menu,
Message > Edit Message As New

After editing the message you can send it off as discussed above.
Receiving Mail
To receive mail, click on the Get Mail button at the top. When prompted, enter your email password (POP3
password) and the email will be downloaded from your Internet mailbox and stored into the Inbox folder. Of course

you will have to be online to perform this.
Deleting Mail
To delete mail messages, select the folder in which the messages are stored in, and in the top right display panel
where the list of messages are displayed, select a message by clicking on it and then click on the Delete button at
the top.

The deleted mail is moved to the Trash folder in the account currently being used. To permanently delete them you
can either delete them from the Trash folder or click on the Trash folder, and from the main menu at the top, select,
File > Empty Trash

You can also right click on the trash folder and choose Empty Trash.
Folders
The various folders allow you to organize your email so that you can group and file them under appropriate folders.
By default, when you create a new mail account, the Inbox, Trash, Drafts, and Sent folders are created
automatically for you. To create a new folder perform,
File > New > Folder

You can file or move your messages from one folder to another by clicking on the list of messages displayed in the
top right panel when the source folder is selected and dragging and dropping them into the destination folder in the
usual manner.
Account Configuration
You can customize your account email settings by selecting,
Edit > Account Settings

There are several important settings which you should be aware of.
Account Settings
In this main configuration screen, you can configure your name, Internet email address and organization name to
use as well as the account name which refer to these settings under Thunderbird.
In particular, the "Compose messages in HTML format" box should not be checked if you want to compose and
send your email messages using just plain text. Optionally, you can leave the box checked and when you send it
you will see a box that gives you the option to send it as plain text.
Server Settings
Here you can configure the name of your POP3 mail server. You can also configure whether you want the mail to
be deleted from the POP3 server after downloading them into your computer. Usually you will want them to be
deleted and so you should ensure that the “Leave messages on server” box is not checked.
Outgoing Server (SMTP)

This is where you can configure the outgoing mail server which will process your outgoing mail.
All other Configuration
The account configuration affects only the account in question to enable you to configure multiple email accounts
each with possibly its own servers. The global configuration affects the entire mail subsystem. To access the global
configuration, select,
Edit > Preferences
Under this configuration, you can set global preferences which will affect all the accounts configured by you in
Thunderbird. These will include the look and feel of Mail itself, the way messages are displayed, format for sending
etc.

Keyboard Shortcuts

Papawoob

The keyboard shortcuts listed in this article are already configured on a standard PCLinuxOS install. You can
change these or add new ones by going to:
Kde Control Center > Regional & Accessibility > Keyboard Shortcuts

Navigation
Alt+Tab = Switch to the next program. When you press this key combination a list of all the open applications on your desktop will
appear. (If you only have 2 applications open you will switch to the other application) If you continue to hold the Alt key, you can use
the Tab key to scroll to the application you wish to switch to. Simply releasing the Alt key will switch to the selected application.
Alt+Shift+Tab = will switch to the previous program
Windows
Alt + F3 = Brings up the Window Operations Menu
Alt + F4 = Closes the window that is on top (in focus)
Alt + Ctrl + A = Activate Window Demanding Attention
Miscellaneous
Alt + F12 = Mouse Emulation
Ctrl + Alt + Esc = Starts xkill. Your cursor should turn into a skull and crossbones. Click on any application to kill it
Alt + Print = Window Screenshot
Ctrl + Print = Desktop Screenshot
Panel
Alt + F1 = Opens the Start Menu
Alt + Ctrl +D = Allows you to hide the open windows on your desktop and then bring them back when you are ready.
Desktop
Alt + F2 = Opens a dialog box for you to use the 'run' command. Type the name of the application you want to run.
Ctrl + Esc = Brings up the Task Manager
Alt + F5 = Shows the list of open Windows
Alt + Ctrl + Insert = Switch User
Alt + Ctrl + L = Locks the screen
Alt + Ctrl + Delete = Logs you out
Alt + Ctrl + Shift + Delete = Log out without confirmation
Ctrl + Alt +Shift + Page Down = This will shut down the computer without confirmation
Ctrl + Alt +Shift + Page Up = This will reboot the computer without confirmation
Clipboard

Alt + Ctrl + V = Show Klipper PopupMenu
Alt + Ctrl + R = Manually Invoke Action on Current Clipboard
Alt + Ctrl + X = Enable/Disable Clipboard Actions
Keyboard
Alt + Ctrl + K = Switch to Next Keyboard Layout
The rest of the following key combinations are also preconfigured on a default PCLinuxOS install.
MiddleMouseButton
Paste the highlighted text. You can highlight the text with your left mouse button (or with some other highlighting method, depending on
the application), and then press the middle mouse button to paste. This is the normal copypaste way in the X Window System, but it
may not work in some X applications.
If you have a twobutton mouse, pressing both of the buttons at the
same time has the same effect as pressing the middle one. If it
doesn't, you must enable 3mousebutton emulation.
Ctrl + Alt + Backspace
Kill the X server. Use this if X crashes and you can't exit it normally. If you've configured your X Window System to start automatically at
bootup, this restarts the server and throws you back to the graphical login screen.
Ctrl+Alt + one of the function keys (F1F6)
Displays a new screen. F1 through F6 are text (console) screens and F7 is a graphical screen.
Ctrl + Alt + F7
Switch back to the GUI. If you have X Window System running, it runs in the seventh virtual terminal by default. If X isn't running, this
terminal is empty.
This one I just learned about. I wish I had known how to do this for years now.
Ctrl + Shift + Num Lock
Will turn the numpad on the keyboard into the mouse. In other words, you can use your numpad to control your mouse pointer. A dialog
window will popup like the one seen below:

Click on the Continue button. You can now use the arrow keys (2,4,6,8) on your numpad to move the mouse cursor
around the desktop. The (/) key on your numpad selects a left mouse click and the (*) key selects a right mouse
click. To actually make the click, press the (5) key on your numpad.
When you press the Ctrl + Shift +Num lock key combination again to revert back to using your mouse you will see
the above dialog window again. This time it will ask you if you want to deactivate "Mouse Keys." Click Continue
again and you will be back to using your mouse again.
When filling in forms:
Tab
Switch to the next field (as expected)
Shift+Tab
Switch back to the previous field (very useful)

How to Repair a Broken xorg.conf

Sysero

Note: I wrote this short "How To" with the very new Linux user in mind. Many others have posted similar easy fixes
for this same problem to help out our new friends. I just wanted to share one that I use in a friendly tutorial format.
Feel free to add to this "How To" tutorial in any way you all see fit! Cheers!
Help!
Sooner or later it's going to happen. You're as happy as a clam with your shiny new PCLinuxOS install. You can't
wait to get home from work to play some more. You arrive, run to the PC, you start it up and suddenly you see a
bunch of confusing words on the screen, something about xorg.conf and then this appears:
"Dropping you to a limited shell."

No familiar login screen; no fancy desktop you spent hours making just right; no really cool wallpaper; just a
flashing cursor and a login prompt. You'll be saying: "Great. What happened?!? Things were fine when I shut down
last night. Now what?!?" (Well ok, maybe not that phrase exactly, but perhaps something containing stronger
language and a flurry of colorful metaphors.)
Anyway, here's what happened. To put it as confusingly as possible, a misconfiguration occurred within xorg.conf
preventing the KDE interface from loading. Huh?

What we mean here is that something inside of a file called xorg.conf is messed up and needs to be fixed. There
are several ways to fix it. I'm going to show you the one I've used a few times. Write it down too. You'll have a quick
fix handy.
What's xorg.conf?
Normally, xorg.conf is a happy little file that's quite content to go about it's day and not bother you. It's true. Trust
me, I'm really good friends with it. It resides on your PC in the directory: /etc/X11 and its job is making sure that
your configuration is correct so that Linux can open KDE and your desktop. Sometimes, xorg.conf also lives with
it's father, xorg.conf.old in this directory. His job is to make lasagna for his son and sit around watching TV, waiting
for something to go wrong. When it does, like any concerned father, he can fix things. But there's one catch: You
have to tell him to fix things. That's what we're going to learn today: How to put xorg.conf.old into action. But, how

did xorg.conf get so confused and messed up?

It gets messed up for one reason or another, especially when you play around with your video card configuration.
Let's get underway and make a backup copy of your good, working xorg.conf so it will be there in case the
inevitable should strike tomorrow. You know what they say: An ounce of prevention is worth two pounds fifty on the
open market, or... something like that.
Backing up xorg.conf
Log out and log back into KDE as root for a moment. Click on your "Home" icon. To the far left you will see a
vertical bar with a star, a clock, a house, a globe, a red folder, a red flag and a computer. Click on the red folder.
Now you see the root folder menu. Double click on "etc." Scroll down and double click on "X11". Now look around
for xorg.conf. Chances are, xorg.conf.old is there, but, just to be sure that you have a working, uncorrupted backup
copy, let's replace it.
Left click once on xorg.conf.old. Now right click on it, and choose "Delete". Next left click once on xorg.conf and
then right click on it, and choose "Copy". Now then, select "Edit" from the menu above and then "Paste Clipboard
Contents". A box will pop up saying the file already exists and asks if you would like to rename it. Rename it to:
xorg.conf.old

All done. You have a working backup copy. Next, let's learn how to use xorg.conf.old when something bad happens.
Continuing on from the example above: "Dropping you to a limited shell." You are now faced with the login prompt.
Repairing xorg.conf
(Write the following down for future use)
At the login prompt, type:
root

Hit "Enter" then type your root password.

Hit "Enter" again. Now you are logged in as root. Now type:

cd etc/X11

Hit "Enter". Now type:
touch xorg.conf.old

Hit "Enter". Now type:

mv xorg.conf.old xorg.conf

Hit "Enter". It will ask if you want to overwrite the file. Type:
y

Hit "Enter". All done. Now simply reboot your computer by typing either:
reboot
or

shutdown r now

After reboot, log in and continue to enjoy this great Linux distro!

Česká republika

You Mean it Works Without Pictures?

Dagaz

We all know Firefox, Opera, Seamonkey and other WWW browsers, but how about browsing the net GUIfree, no
flash animations, no pictures of any format, javagimmicks, just plain text? Lynx does the trick. It is one of the text
based browsers you can install via Synaptic. Once installed, open a konsole (an icon should be on your Desktop
on .93 and older installations) or Ctrl+Alt+F1 which will open at terminal at tty1.
Let us play with the Magazines website.
In konsole or at tty1 type:
lynx www.pclosmag.com
(The Lynx default homepage is set to:www.pclinuxos.com in /usr/share/lynx/lynx.cfg)

You will see a highlighted blue bar with text in it. This is the 'status bar'. PCLosmag wants to set a cookie and
waits for your OK.
Hit SHIFT+A and you will not be asked again during this session.
Here we are, the PCLOSMAG homepage:

Fig. PCLOSMag homepage
Lynx can not display Tables or Frames, therefore it puts everything in 'order' from top to bottom 'as it comes in.' In
the top right hand corner you see where you are and a page counter.
The word help in the top left corner is yellow. (Note: Your konsole might look different because your schema is set
to something other than Linux colors. You can change it under: Settings>Schema>Linux Colors)
The yellow color shows you which link is currently 'selected'. Only valid Links will change colors. You see Home,
Forum, Links, Search, Downloads twice because it really is on the main page two times.
Moving around:

To move to the next valid link press the arrow down or Tab key, arrow up to the previous link. Space or Page Down
jumps you to the next page, Page Up jumps back one page. To follow a link hit the right arrow key or Enter, to go
back, use the arrow left key. In case you forget, have a look at the bottom of the screen.
Let's login to the Forum:

Hit the arrow down key until Forum (it does not matter which one) is YELLOW and hit Enter. Arrow down key again
until a yellow Block cursor appears on the first green line (behind register). Type in your LOGIN name, hit Enter,

type in your password, hit Enter. [Forever] is an option on the list. Enter will show you all options. Arrow up, down
selects entry. Hit Tab to get to Login. One more time Enter and we are almost there.

Fig. Forum Login
You will come up with something like this:

Fig. Forum Redirect

Lynx does not work with the htmlrefresh on some systems, so just hit Enter and you should see the main page
again, however there is one difference. This time you are logged in. Hit the Space bar or the page Down key once.

Fig. Logged In
See the 'Hey, DAGAZ'? I am logged in. Now to get to the topics and posts, hit arrow up to get to page 1 and select
Forum again (it must be yellow). Hit enter or right arrow and you should land here:

Fig. Forum Main
Space bar, Page Down tab trough the pages (we are at page 1of 4). Let us go to
the 'You mean it works without pictures?' post.
Hit Space or Page Down until you see:
No New Posts Requested Articles
Articles that you would like to see in the Magazine

Use arrow down key until Requested Articles is Yellow (Requested Articles)
Hit enter and find: You mean it works without pictures?
As always, arrow down until You mean it works without pictures? turns yellow and hit enter. You are now in:
PCLinuxOS Magazine > General Category > Requested Articles (Moderator: GuypronouncedGuy) > You mean it
works without pictures?
Page Down or Up to display the different pages and that is basically it. just remember:
(NORMAL LINK) Use rightarrow or <Enter/Return> to activate.
Arrow keys: Up and Down to move. Right to follow a link; Left to go back.

To get out of Lynx hit 'q' and acknowledge with 'y'.
To open another webpage hit 'g' and type in your URL (www.xyz.com)
This is just the basics to get around in Lynx. You can do much more with it, however it would blow a little howto.
Need more info? Hit 'h' for a built in help.
Well, hope this helped a little.

PCLOS Based Distros

Papawoob

Just thought I would try and bring everyone a list of currently active PCLinuxOS based distros. If I have missed any,
I apologize. If anyone knows of any others that are being actively developed please drop me a note at the
Magazine website or at Papawoob@pclosmag.com.
AmaroK Live

amaroK Live is a strippeddown live CD of the GNU/Linux operating system, based on PCLinuxOS, with a fully
functional amaroK music player. It is meant to display the features and power of amaroK. The goals of this project
are: create something cool to promote amaroK, offer an easy way to introduce people to amaroK, provide a way to
demonstrate the new features of amaroK when a suitable Linux installation is not available, and make it easy to
remaster the live CD.
ArcheOS

ArcheOS is an acronym for Archaeological Operating System. It is a GNU/Linux live DVD distribution, based on
PCLinuxOS, with specialist software for archaeological purposes.
Granular Linux

Granular Linux is an easytouse, desktop Linux distribution based on PCLinuxOS. Its main features are a carefully
selected set of applications for common tasks, the ability to customize the distribution, and the inclusion of two
popular desktop environments  the flexible KDE and the lightweight Xfce.
Karoshi

Karoshi is a free and open source school server operating system based on PCLinuxOS. Karoshi provides a simple
graphical interface that allows for quick installation, setup and maintenance of a network.
Ruby on Rails

Rails Live CD is a specialist distribution providing a preconfigured and fully operating Ruby on Rails development
environment on a bootable CD. The distribution is derived from PCLinuxOS.
SAM Linux Desktop

SAM Linux Desktop, a live and installation CD based on PCLinuxOS, is an easytouse, fast and clean XFce Linux
desktop for home users. The distribution is enhanced by several popular nonfree applications, such as
Macromedia Flash plugin, Java and RealPlayer.
VideoLinux

VideoLinux is a PCLinuxOSbased distribution with focus on DVD backups, video encoding and transcoding, DVD
authoring, format conversion and pretty much anything else you want to do with video.
TinyMe

TinyMe is a scaled down version of PCLinuxOS 2007. The latest version is delivered as a 177 MB liveCD and
features the Lightweight X11 Desktop Environment, Synaptic, and the PCLinuxOS Control Center. It comes with a
few applications, so it could be a really light version of PCLOS for older computers or a foundation on which to build
your own system as you choose.
PCFluxboxOS

PCFluxboxOS is a series of remasters of PCLinuxOS catering for different enduser needs. All the following
remasters are installable liveCDs and all come with the i586 'Legacy' Kernel 2.6.18.8 for increased compatibility
with older hardware. Newer kernels can be installed via Synaptic.
TinyFlux  Version 0.5b out now for testing (released 15 August 2007)
A minimal desktop experience within a tiny ISO of 225MB.
Main applications: Opera (inc Flash 9); Sylpheed (email); Thunar (file manager); Audacious (XMMS/WinAmp
clone); mtPaint (image manipulation); Grafburn for CD/DVD burning; Synaptic (package manager); PCLOS Control
Centre; guided installer.
See TinyFlux downloads page for full details
MidiFlux  release expected September 2007
A large selection of applications in a relatively small ISO expected to be about 350MB in size
FullFlux  release expected September 2007
A huge selection of apps in a whopping 700MB full live CD

NanoFlux  release expected October 2007
A miniscule distribution stripped down to Fluxbox and Synaptic. Add your own apps to build your perfect system!
RescueFlux  release expected November 2007
A small ISO containing all the apps you might need to prepare for, or rescue an installation.
Disclaimer
All the contents of PCLinuxOS Magazine (pclosmag.com) are only for general information and/or use. Such contents do
not constitute advice and should not be relied upon in making or refraining from making any decision. Any specific
advice or replies to queries in any part of the magazine is the personal opinion of the contributers and are not
subscribed to by PCLinuxOS Magazine.
The information in PCLinux Magazine is provided on an "AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice or replies are disclaimed and excluded.
PCLinuxOS Magazine and its associates shall not be liable, at any time for damages (including without limitation,
damages from loss of any kind) arising in contract, tort, or otherwise from the use of or inability to use the magazine
or any of its contents, or any of its contents, or from any action taken or not taken as a result of using the magazine or
any contents or for any failure of performance, error, ommission, interruption, deletion, defect, delay in operation or
transmission, computer virus, communications line failure, theft or distruction or unauthorized access to, asteration of,
or use of information contained in the magazine.
No representations, warranties, or guarantees whatsoever are made as to the accuracy, adequacy, reliability,
completeness, suitability, or applicability of the information to a particular situation.
Certain links on the magazine lead to resources located on servers maintained by third parties over whom PCLinuxOS
Magazine has no control. By visiting these, you are doing so of your own accord and assume all responsibility for such
action.
These terms constitute the entire agreement between the parties with respect to the subject matter hereof and
supercedes and replaces all prior or contemporaneous understandings or agreements, written or oral, regarding such
subject matter.

